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1. Introducere

Modulul MODELAREA 3D  este destinat pregătirii elevilor din  domeniul TEHNIC, nivel 3, clasa a XII-a – Liceu tehnologic, specialitatea Tehnician CAD

Pentru acest modul sunt prevăzute în Planul de învăţământ pentru Liceul tehnologic în cadrul Curriculumului în dezvoltare locală 76 de ore dintre care, 62 de ore de laborator tehnologic.

Prezentul auxiliar curricular se adresează atât elevilor, cât şi profesorilor. El are rolul de a orienta profesorul.

Activităţile propuse elevilor, exerciţiile şi rezolvările lor urmăresc atingerea majorităţii criteriilor de performanţă respectând condiţiile de aplicabilitate cuprinse în Standardele de Pregătire Profesională

Programa modulului trebuie utilizată împreună cu Standardul de Pregătire Profesională pentru a corela, în permanenţă, criteriile de performanţă ale competenţelor agregate în modul cu conţinuturile incluse, rezultate din condiţiile de aplicabilitate ale criteriilor de performanţă respective.

Parcurgerea conţinuturilor se va realiza în integralitatea lor. 

Pentru atingerea competenţelor specifice stabilite în modul, profesorul, are libertatea  de a dezvolta anumite conţinuturi, de a eşalona în timp, de a utiliza activităţi variate de învăţare şi în special cele cu caracter aplicativ, centrate pe elev.

Înainte de aplicarea materialelor de învăţare propuse, profesorul trebuie să cunoască particularităţile colectivului de elevi şi, îndeosebi, stilurile de învăţare ale acestora, pentru reuşita centrării pe elev a procesului instructiv; el poate adapta materialele în raport cu cerinţele clasei.

Materialele de învăţare sunt uşor de citit şi de înţeles, informaţiile fiind formulate într-un limbaj adecvat nivelului elevilor, accesibil şi susţinut prin exemple sugestive şi prin imagini.

Evaluarea trebuie să fie un proces continuu şi sumativ, referindu-se în mod explicit la criteriile de performanţă şi la condiţiile de aplicabilitate ale acestora, corelate cu tipul probelor de evaluare specificate în Standardul de Pregătire Profesională, pentru fiecare competenţă. 

O competenţă se evaluează o singură dată, iar elevii vor fi apreciaţi numai în ceea ce priveşte dobândirea competenţelor specificate în tabelele de corelare ale competenţelor cu conţinuturile.
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2. Competenţe

Competenţele prevăzute de Standardele de Pregătire Profesională pentru:

Filiera



Tehnologică
Profilul


Tehnic
Nivelul


3
Specializarea

Tehnician proiectant CAD
Unitatea de competenţă 
27. MODELAREA 3D, sunt:

27.1
Crează modele wire-frame 2 ½ D

27.2
Crează modele wire-frame 3D

27.3
Crează suprafeţe 3D

27.4
Realizează desene 3D în modul „multi view”

27.5
Realizează desene 3D în perspectivă

3. Obiective

În urma parcurgerii acestui modul, elevii vor putea:

· Să utilizeze sistemele de referinţă şi coordonatele specifice aplicaţiei AutoCAD

· Să realizeze desene în 2D cărora să le confere proprietăţi de modele 3D
· Să afişeze desenele utilizând comenzile de vizualizare

· Să realizeze desene 3D în modul wireframe

· Să adauge text şi cote unui model 3D

· Să realizeze desene 3D de corpuri solide

· Să realizeze secţiuni prin modele 3D

· Să creeze suprafeţe 3D simple şi complexe

· Să folosească facilităţile aplicaţiei AutoCAD de umbrire a suprafeţelor
· Să afişeze un desen în modul „multiview”

· Să realizeze trecerea de la reprezentarea în proiecţie paralelă la reprezentarea în perspectivă
4. Informaţii pentru profesori 

	Competenţe
	Obiective
	Activităţi de învăţare
	Conţinuturi

	27.1
	· Să utilizeze sistemele de referinţă şi coordonatele specifice aplicaţiei AutoCAD

· Să realizeze desene în 2D cu proprietăţi de obiecte 3D

· Să afişeze desenele utilizând comenzile de vizualizare


	A1
A2


	· Tipuri de coordonate. Modul de introducere

· Sistemul de coordonate al utilizatorului

· Elevaţia şi grosimea (Thickness Elevation)

· Crearea regiunilor 

· Pregătirea spaţiului de lucru. Vizualizarea desenelor

	27.2
	· Să realizeze desene 3D în modul wireframe

· Să realizeze desene 3D de corpuri solide

· Să adauge text şi cote unui model 3D

· Să realizeze secţiuni prin modele 3D


	A3

A4

A5

A6

A7

A8

A9
	· Utilizarea comenzilor de desenare 2D pentru crearea modelelor wireframe

· Primitive şi operaţii booleene

· Comenzile REVOLVE şi EXTRUDE
· Cotare. Inserare texte

· Utilizarea comenzii SLICE pentru secţionarea corpurilor



	27.3
	· Să creeze suprafeţe 3D simple şi complexe

· Să folosească facilităţile aplicaţiei AutoCAD de umbrire a suprafeţelor
	A10

A11

A12

A13

A14
	· Utilizarea comenzilor 3DFACE, 3DMESH pentru crearea suprafeţelor simple

· Utilizarea comenzilor REVSURF, TABSURF pentru crearea suprafeţelor complexe

· Comanda SHADEMODE de umbrire a suprafeţelor

	27.4
	· Să afişeze un desen în modul „multiview”


	A15
A16
	· Noţiunile de MODEL SPACE şi PAPER SPACE
· Utilizarea punctelor de vedere TILED

	27.5
	· Să realizeze trecerea transforme o vedere din proiecţie paralelă într-o vedere în perspectivă 
	A17
	· Utilizarea comenzii DVIEW pentru realizarea desenelor în perspectivă


5. Fişe de rezumat

Pentru înregistrarea progresului elevilor, sunt foarte utile Fişele de rezumat. Acestea reprezintă înregistrări ale activităţilor de învăţare corespunzătoare fiecărei competenţe din Standardele de Pregătire Profecională, ce trebuie realizate de fiecare elev pe parcursul modulului.

Fişele de rezumat mai cuprind, de asemenea, comentarii ale profesorului în legătură cu atitudinea elevului, rezultate pozitive în atingerea unor anumite obiective şi calea de urmat în continuare pentru fiecare elev şi, foarte important, comentarii ale elevului referitoare la activităţile desfăşurate. În acest fel, elevii sunt încurajaţi să-şi asume răspunderea în procesul de învăţare. Comentariile lor pot oferi cadrelor didactice informaţii referitoare la dificultăţile întîmpinate.

Vom da mai jos exemple de fişă de rezumat a modulului şi fişă de rezumat de activitate.

Acestea pot fi modificate pentru a fi adaptate necesităţilor fiecărui cadru didactic.

Fişa de rezumat a modulului

	MODELAREA 3D

	Numele elevului:
	

	Data începerii:
	
	Data finalizării:
	

	Competenţe
	Activitate de învăţare
	Data îndeplinirii
	Verificat

	Competenţa 1

Crează modele wire-frame 2 ½ D

	
	
	

	
	
	
	

	
	
	
	

	Competenţa 2

Crează modele wire-frame 3D

	
	
	

	
	
	
	

	
	
	
	

	Competenţa 3

Crează suprafeţe 3D
	
	
	

	Competenţa 4

Realizează desene 3D în modul „multi view”
	
	
	

	Competenţa 5

Realizează desene 3D în perspectivă
	
	
	


Fişa de rezumat a activităţii

	Competenţă
	Activitate de învăţare
	Obiectivele învăţării
	Realizat

	Detalii referitoare la competenţa care se dezvoltă.
	Denumirea sau alte precizări referitoare la activitatea de învăţare
	Obiectivul(ele) activităţii de învăţare

Această activitate   va …
	Data la care obiectivul învăţării a fost îndeplinit

	
	Comentariile elevului

De exemplu:

· Ce le-a plăcut referitor la subiectul activităţii.

· Ce anume din subiectul activităţii li s-a părut a constitui o provocare.

· Ce mai trebuie să înveţe referitor la subiectul activităţii.

· Ideile elevilor referitoare la felul în care ar trebui să-şi urmărească obiectivul învăţării.

	
	Comentariile profesorului

De exemplu:

· Comentarii pozitive referitoare la ariile în care elevul a avut rezultate bune, a demonstrate entuziasm, s-a implicat total, a colaborat bine cu ceilalţi.

· Ariile de învăţare sau alte aspecte în care este necesară continuarea dezvoltării.

· Ce au stabilit elevul şi profesorul că ar trebui să facă elevul în continuare luând în considerare ideile elevului despre cum le-ar plăcea să-şi urmeze obiectivele învăţării.


6. Glosar de termeni

	2-D
	O metodă de reprezentare a obiectelor reale pe o suprafaţă plană utilizând  lungimea şi lăţimea. Acest sistem foloseşte doar axele X şi Y.

	3-D
	O metodă de reprezentare a obiectelor reale într-un mod mai apropiat de realitate, adăugând adâncime lungimii şi lăţimii. Acest sistem foloseşte doar axele X şi Y. Acest sistem foloseşte axele X Y şi Z.

	Operaţii booleene
	Comenzi ce permit unirea sau extragerea sau intersectarea corpurilor solide în AutoCAD.

	Elevatie
	Diferenţa dintre un obiect care se găseşte la nivelul 0 pe axa Z şi o înălţime deasupra nivelului 0.

	Faţă
	Cea mai simplă suprafaţă 3D.

	Ascunderea a liniilor 
	O modalitate de ascundere a liniilor care nu sunt vizibile atunci cân privim modelul 3D.

	Desen izometric
	O metodă simplă de a obţine o vizualizare  '3-D' utilizând metode de desenare 2D..

	Vedere plană
	O vedere realizată de pe direcţia unei axe spre un plan.

	Primitive
	Un bloc al unei construcţii simple, primare, pe baza cărora se construiesc obiectele  complexe. (cilindru, prismă, sferă, etc.).

	Regiuni
	O arie 2D închisă constând din linii, arce, etc. cu proprietăţi de obiect 3D de ex. umbrire

	Randare
	O modalitate complexă de a adăuga caracteristici foto-realiste unui model 3D creat.

	Umbrire
	O modalitate rapidă de adăugare a culorii unui model 3D creat.

	Model solid
	Un model 3D creatl utilizând primitivele solide.  Reprezintă modalitatea cea mai realistă de a reprezenta obiectele reale în AutoCAD.

	Model Suprafaţă
	Un model 3D definit de suprafeţe. Suprafeţele reprezintă poligoane

	Înălţime
	O proprietate a obiectelor 2D cele le conferă un aspect 3D.

	UCS
	Sistemul de coordonate al utilizatorului, definit de persoana care desenează, pentru a-I facilita accesul la anumite porţiuni din ale modelului 3D.

	View


	O reprezentare a unei anumite vizualizări a obiectului creat.

	Viewport
	O fereastră în desen, în care se poate reprezenta o anumită vedere. Pe un ecran se pot crea  mai multe view-porturi.

	Wire-frame Model
	Un model 3-D definit de linii şi curbe. Este o reprezentare a “scheletului” modelului.  Îndepă[rtarea liniilor acoperite nu e posibilă.

	Axa Z
	Axa ce defineşte adâncimea.

	
	

	
	


Acest glosar poate fi completat de fiecare elev şi ataşat portofoliului personal.

7. Informaţii pentru elevi

Scopurile şi obiectivele fiecărui activităţi de învăţare vor fi menţionate pe pagina introductivă a acesteia  alături de o descriere  clară a relaţiei dintre competenţele modulului relevante pentru activitatea respectivă, obiective şi sarcini de lucru, întrebări sau probleme menţionate în fişele de lucru ataşate.


Inainte de rezolvarea sarcinilor de lucru aferente unei activităţi este util ca, la recomandarea profesorului, elevii să studieze materiale bibliografice, în legătură cu tema care va fi analizată la respectiva activitate. Profesorul şi elevul vor stabili când şi sub ce formă se va desfăşura acest studiu: individual sau în grup, la clasă, cu sprijinul profesorului. La finalizarea acestui studiu elevii pot susţine un test de evaluare iniţială.


Activităţile sunt organizate fiecare pe mai multe fişe de activităţi, cu nivele de dificultate diferite, astfel nu este obligatoriu ca toţi elevii să rezolve simultan aceleaşi sarcini de lucru; profesorul şi elevi vor stabili modul de diferenţiere a activităţii în funcţie de structura colectivului şi de nivelul de pregătire al elevilor.


La finalizarea sarcinilor de lucru menţionate într-o fişă de lucru, elevii vor nota răspunsurile date la întrebări sau vor consemna îndeplinirea sarcinilor de lucru în fişa de evaluare ataşată, fiind astfel posibilă o autoevaluarea a activităţii de către elevi. Profesorul va verifica rezultatul muncii elevilor şi va confirma corectitudinea răspunsurilor date în aceeaşi fişă de evaluare. Profesorul împreună cu elevul vor stabili un plan de măsuri privind sarcinile de lucru individuale de realizat în viitor de către elevi. Acestea  pot fi: consultarea materialului teoretic pe tema analizată în activitatea respectivă, rezolvarea unor sarcini de lucru de o mai mare complexitate, din altă fişă de lucru.


Fiecare elev va dispune de o fişă de lucru individualizată, de o fişă de evaluare a activităţii şi de o fişă rezumat a activităţii unde va avea prilejul să noteze propriile comentarii privind desfăşurarea activităţii.
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8. Activităţi de învăţare

Activitate de evaluare
EVALUARE INIŢIALĂ

Obiectivul activităţii

Prin această activitate dorim să vedem în ce măsură cunoştinţele tale anterioare pot fi valorificate în cadrul următoarelor activităţi 

Tipul de activitate

completare fişa de evaluare
Timpul alocat

50 minute
Bifaţi răspunsurile corecte din fişa de evaluare de mai jos:

1. Din ce direcţie începe AutoCAD măsurarea unghiurilor?

[image: image1.wmf]ora 12

[image: image2.wmf]ora 3

[image: image3.wmf]ora 6

[image: image4.wmf]ora 9

2. Care este denumirea corectă a WCS?

[image: image5.wmf]Western CAD System

[image: image6.wmf]Worldwide Coordinate Sectors

[image: image7.wmf]World Coordinate System

[image: image8.wmf]Wrong CAD Settings

3. Când desenăm în 2D, care axă nu este utilizată?

[image: image9.wmf]X

[image: image10.wmf]Y

[image: image11.wmf]Z

[image: image12.wmf]WCS

4. Într-un desen, 300o este acelaşi lucru cu -60o ?

[image: image13.wmf]da

[image: image14.wmf]nu

[image: image15.wmf]nu întotdeauna

[image: image16.wmf]niciodată

5. Care dintre aceste comenzi nu determină imprimarea?

[image: image17.wmf]Tastarea  PLOT

[image: image18.wmf]Tastarea PRINT

[image: image19.wmf]Apăsarea tastelor Control+P

[image: image20.wmf]Apăsarea tastelor Alt+P

6. Ce trebuie să urmărim atunci când învăţăm o comandă AutoCAD?

[image: image21.wmf]Linia de comandă

[image: image22.wmf]Brara de stare

[image: image23.wmf]Bara de titlu

[image: image24.wmf]Iconul instrumentelor

7. Coordonatele polare se utilizează în special pentru desenele .........?

[image: image25.wmf]cercuri

[image: image26.wmf]arce

[image: image27.wmf]linii verticale

[image: image28.wmf]linii înclinate

8. Ce taste determină anularea unei comenzi anterioare?

[image: image29.wmf]Control+U

[image: image30.wmf]Alt+U

[image: image31.wmf]Control+Z

[image: image32.wmf]Alt+Z

9. Când utilizezi comanda TRIM, ce selectezi prima dată?

[image: image33.wmf]Muchiile tăietoare

[image: image34.wmf]Obiectele ce vor fi tăiate

[image: image35.wmf]Totul

[image: image36.wmf]Nimic

10. Câte puncte de SNAP are un obiect?

[image: image37.wmf]Unul

[image: image38.wmf]Două

[image: image39.wmf]Depinde de obiect

[image: image40.wmf]Cel puţin patru

11. De câte puncte e nevoie pentru desenarea unui dreptunghi cu comanda RECTANGLE?

[image: image41.wmf]Unul

[image: image42.wmf]Două

[image: image43.wmf]Patru

[image: image44.wmf]Nici unul

12. Câte obiecte AutoCAD sunt într-un dreptunghi?

[image: image45.wmf]Nici unul

[image: image46.wmf]Unul

[image: image47.wmf]Patru

[image: image48.wmf]Opt

13. Daca desenezi o linie la 270o faţă de axa X pozitivă, capătul ei va fi.

[image: image49.wmf]Sus

[image: image50.wmf]La stânga

[image: image51.wmf]Jos

[image: image52.wmf]La dreapta

14. Ce lungime va avea o linie desenată din punctul de coordonate 1,4 până în punctul de coordonate 4,4?

[image: image53.wmf]4 mm

[image: image54.wmf]8 mm

[image: image55.wmf]nu se poate spune având la dispoziţie numai coordonatele

[image: image56.wmf]3 mm

15. Cât de lungă va fi linia între punctele de coordonate 1,4 şi @4<5 ?

[image: image57.wmf]3 mm

[image: image58.wmf]4 mm

[image: image59.wmf]5 mm

[image: image60.wmf]3.5467 mm

16. Care este cea mai bună metodă de a desena un dreptunghi?

[image: image61.wmf]Utilizând comanda LINE 

[image: image62.wmf]Utilizând comanda POLYLINE

[image: image63.wmf]Utilizând comanda RECTANGLE

[image: image64.wmf]Utilizând comanda MULTILINE

17. Pentru a muta un obiect cu 4mm la dreapta, ce valori trebuie introduse la cerinţa second point of displacement?

[image: image65.wmf]@4,0
[image: image66.wmf]@4<0
[image: image67.wmf]Nici o varianta

[image: image68.wmf]Ambele variante

18. Comanda FILLET crează:

[image: image69.wmf]Muchii ascuţite

[image: image70.wmf]colţuri rotunjite

[image: image71.wmf]Un cerc

[image: image72.wmf]Filetează un peşte

19. Prin comanda ARRAY POLAR se crează noi obiecte...

[image: image73.wmf]Aliniate la liniide de GRID

[image: image74.wmf]În linie dreaptă

[image: image75.wmf]Dispuse într-o formă circulară

[image: image76.wmf]Într-o formă aleatoare

20. Trebuie utilizat modul OSNAP atunci când cotăm...

[image: image77.wmf]Niciodată

[image: image78.wmf]Întotdeauna

[image: image79.wmf]Doar linii

[image: image80.wmf]Doar arce şi cercuri

21. Câte layere trebuie să aibă un desen?

[image: image81.wmf]Unul

[image: image82.wmf]10

[image: image83.wmf]Câte unul pentru fiecare obiect

[image: image84.wmf]Câte sunt necesare pentru afişarea clară a obiectului

22. Când putem schimba înălţimea unui text?

[image: image85.wmf]Doar când începem desenul

[image: image86.wmf]Doar în fereastra de dialog specială

[image: image87.wmf]Doar când începem comandaTEXT

[image: image88.wmf]Nu se poate , este prestabilită în AutoCAD

Activităţi Obiectiv 1 

Obiectiv 1

Să utilizeze sistemele de referinţă şi coordonate specifice aplicaţiei AutoCAD
Fişă de documentare nr.1

INTRODUCERE ÎN MODELAREA 3D

Auto CAD permite trei tipuri de modelare tridimensională:

· Wireframe – cadru de sârmă

· Surface - suprafaţe

· [image: image106.png]MONITOR



Solid – corpuri solide

· Modelarea wireframe (cadru de sârmă) utilizează linii, arce, cercuri şi alte obiecte geometrice pentru a trasa muchiile unui obiect. Pentru a construi un model wireframe, trebuie cunoscut fiecare vârf al obiectului. Obiectul nu va avea suprafeţe vizibile.
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· Modelarea suprafeţelor adaugă suprafeţe fără grosime cadrului de sârmă. Astfel, obiectul va avea înveliş şi vor putea fi folosite opţiunile de umbrire şi ascundere a muchiilor acoperite. Suprafeţele curbe sunt aproximate prin mici poligoane plane ale unei plase poligonale (mesh).
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· Modelarea solidă este cea mai apropiată de obiectul real deoarece se reprezintă nu numai învelişul ci descrie şi volumul interior. Aceste obiecte pot fi analizate din punct de vedere al masei, volumului, greutăţii, propriectăţilor fizice.

Fişă de documentare nr. 2

Tipuri de coordonate

În vederea modelării tridimensionale, punctele sunt identificate prin intermediul coordonatelor lor. Ca şi la modelarea 2D, există trei tipuri de coordonate ce pot fi introduse faţă de originea sistemului de coordonate - coordonate absolute, fie faţă de un punct precizat anterior – coordonate relative.

1. Coordonate carteziene
· Absolute 

Introducerea coordonatelor se face faţă de originea sistemului de coordonate activ.
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Punctul M este introdus prin specificarea coordonatelor sale faţă de originea sistemului de axe: x=150, y=100, z=80

150,100,80

· Relative 

Introducerea coordonatelor unui punct nu se exprimă faţă de origine ci faţă de un punct definit anterior.
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Punctul B(150,100,80) este introdus prin specificarea coordonatelor sale faţă de punctul A(20,140) definit anterior:

@130,-40,80
2. Coordonate cilindrice
Punctul se consideră situat pe suprafaţa unui cilindru circular drept cu baza în planul xOy şi centrul în origine. 

Pentru identificarea punctului sunt necesare raza cilindrului, unghiul cu axa x în planul xOy şi înălţimea la care se găseşte punctul –coordonata z, sub următoarea formă:

[image: image111.png][Command: ucs’
Current ucs name:  *WORLDx

Enter an option [New.Move orthoGraphic,/Prev.Restors/Save /Del Apply,?/World] <Vorld>



raza cilindrului<unghiul cu axa x,înălţimea
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pentru punctul A din figură, coordonatele se introduc astfel: 70<15,60
Pentru indicarea unor coordonate relative se utilizează simbolul @ pus în faţa liniei de coordonate: @70<15,60
3. Coordonate sferice
Punctul se consideră situat pe suprafaţa unei sfere cu centrul în origine. 

Pentru identificarea punctului sunt necesare raza sferei, unghiul cu axa x în planul xOy şi unghiul cu planul xOy, sub următoarea formă:

raza sferei<unghiul cu axa x,unghiul cu planul xOy
pentru punctul A din figură, coordonatele se introduc astfel: 70<15,45
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Pentru indicarea unor coordonate relative se utilizează simbolul @ pus în faţa liniei de coordonate: @70<15,45
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Fişa de documentare nr. 3

SISTEMUL DE COORDONATE AL UTILIZATORULUI UCS

AutoCAD defineşte geometria unui model utilizând coordonatele precise X, Y, Z  faţă de Sistemul de Coordonate Universal – WCS. 
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Orientarea sa fixă, arătată în figură,  este:

· valorile pozitive ale axei X spre dreapta

· valorile pozitive ale axei Y deasupra axei X

· valorile pozitive ale axei Z sunt orientate către utilizator, având direcţia perpendiculară pe ecran.
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La crearea unor desene 2D se utilizează WCS. Punctul de vedere (ochiul observatorului) este chiar deasupra axei Z.

Când se crează modele în coordonate 3D va fi nevoie să stabilim diferite direcţii din care să privim planul XY.

[image: image117.png]


Una din cele mai bune metode pentru a-ţi aduce aminte relaţia dintre axele X, Y, Z este regula mâinii drepte. Această regulă foloseşte trei degete ale mâinii drepte, fiecare dintre ele reprezentând o axă. În figura 1 se poate vedea poziţia degetelor ce materializează direcţia POZITIVĂ a axelor. Unghiul format între fiecare două degete este de 90o. Degetul mare este axa X, indexul este axa Y, iar mijlociul axa Z.

Ţinând degetele în această poziţie şi modificînd poziţia mâinii, se poate observa relaţia dintre axe când sistemul de coordonate se schimbă.

Încearcă să-ţi aşezi degetele în poziţia din figura 1 şi apoi roteşte mâna până când „axele” ajung în poziţia din figura 2. 

Figura 1 arată poziţia corectă a planului XY când privim din faţă un obiect (FRONT). 

Figura 2 arată poziţia corectă a axelor în Sistemul de coordonate WCS, ce corespunde cu observarea de sus a unui obiect (TOP)

Încercaţi şi rotiţi mâna până când orientarea axelor va corespunde cu orientarea din partea dreaptă (RIGHT).

Ce este UCS (User Coordinate System)?

Este un set de coordonate X,Y,Z, definite de utilizator pentru a-l ajuta în crearea modelelor 3D.

Propriul UCS poate avea o origine diferită şi axele rotite faţă de WCS.

UCS-ul este util pentru că mouse-ul se mişcă doar în plan.

Se pot crea oricâte UCS-uri, care se pot salva sub diverse nume, însă DOAR UNUL ESTE ACTIV LA UN MOMENT DAT!
Cum arată icon-ul UCS?

Iconul este întotdeauna desenat în planul XY al UCS-ului curent şi poate avea una din formele prezentate în tabelul de mai jos.
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Comanda UCSICON permite controlarea modului de afişare a iconului UCS.

Command: ucsicon
Enter an option [ON/OFF/All/Noorigin/Origin/Properties] <ON>:


ON
afişează pictograma UCS


OFF
ascunde pictograma UCS


A
controlează afişarea iconului în toate vederile definite

N
determină afişarea pictogramei în colţul din stânga jos, indiferent de poziţia originii

OR
forţează plasarea iconului chiar în originea sistemului de coordonate

P
oferă posibilitatea stabilirii formei, mărimii, culorii, vârfurilor axelor şi grosimii axelor iconului

Cum definim un UCS?

AutoCAD ne oferă mai multe variante pentru a defini un sistem de coordonate al utilizatorului. Toate aceste opţiuni sunt disponibile utilizând:

· Comanda UCS de la tastatură
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· Meniurile derulante : Tools[image: image89.png]


UCS[image: image90.png]
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· Bara cu instrumente
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Activitate de învăţare nr.1

Obiectivul activităţii

Această activitate vă va ajuta să vă formaţi deprinderea de a utiliza sistemul de coordonate propriu (UCS) în funcţie de necesităţile modelului

Tipul de activitate

Efectuare de exerciţii
Timpul alocat

40 minute
Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici, 2-3 elevi
Vom face exerciţii de utilizare a UCS-ului pentru modelul wireframe existent (o piramidă), alegând diferite opţiuni din comanda UCS.

Urmăriţi linia de comandă din prima coloană, explicaţi în linia următoare a tabelului efectul comenzii şi, acolo unde lipseşte, desenaţi sistemul de coordonate în noua poziţie.

	Linia de dialog
	Pozţia UCS

	
	Înainte
	După aplicarea opţiunii

	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: M
Specify new origin point or [Zdepth]<0,0,0>: END
Of (se indică P)
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: M
Specify new origin point or [Zdepth]<0,0,0>: Z
Specify Zdepth<0>: 40
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: 3
Specify new origin point <0,0,0>: end

Of (se indică P1)
Specify point on positive portion of X-axis <8.7489,35.0000,0.0000>: end

Of (se indică P2)
Specify point on positive-Y portion of the UCS XY plane 

<8.3450,35.8030,0.0000>: end

Of (se indică P3)
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: Y
Specify rotation angle about Y axis <90>: -90
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: Z
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Specify rotation angle about Z axis <90>:
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: X
Specify rotation angle about X axis <90>:-90
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: ZA
Specify new origin point <0,0,0>:

Specify point on positive portion of Z-axis <0.0000,0.0000,1.0000>: mid
Of (se indică P)
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	Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World] 

<World>: N
Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: V
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Activităţi Obiectiv 2 

Obiectiv 2

Să realizeze desene 2D cărora să le confere proprietăţi de modele 3D
Fişă de documentare nr. 4

Modele 21/2 D. Comenzile ELEV şi THICKNESS

Atunci când realizăm desene în plan (2D), valoarea coordonatei z, deşi nu e precizată, este considerată 0. Alegerea unei valori diferite de zero pentru această variabilă, va avea ca efect desenarea tot într-un plan, dar situat la înălţinea z faţă de planul iniţial (cu z=0).

Valoarea coordonatei z este fixată printr-o variabilă numită ELEVATION. 

Comanda ELEV stabileşte elevaţia şi grosimea obiectelor ce urmează a fi desenate.

Command: elev
Specify new default elevation <0.0000>: (se scrie o valoare pentru noul nivel)
Specify new default thickness <0.0000>: (se scrie o valoare pentru noua grosime)
[image: image139.png]I Viewpoint Presets

SetViewing Anles
® Absoluts to WES O Relative to UCS
a0
&5
e
a0

100
1

100
00
a5

50
8-





În exemplul de mai sus am desenat obiectele (cerc, polilinie, linie, arc) în plan, dar la o anumită înălţime (elevation) faţ de planul xOy
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Comanda THICKNESS stabileşte grosimea obiectelor ce urmează a fi desenate

Command: thickness
Enter new value for THICKNESS <0.0000>: (se scrie o valoare pentru noua grosime)
În exemplul de mai sus am fixat o grosime (thickness) obiectelor plane desenate anterior.

Fişa de documentare nr.5

Modele 21/2 D. Crearea regiunilor 2D

Regiunile sunt suprafeţe bidimensionale care se comportă ca şi obiectele solide, având următoarele proprietăţi:

· Ascunderea obiectelor aflate în spatele lor

· Crearea unor regiuni compozite cu ajutorul operaţiilor booleene

· Conţin informaţii referitoare la arie, centrul de greutate

Aceste suprafeţe bidimensionale se pot realiza cu comanda REGION.

Comanda are ca efect convertirea unei succesiuni de linii, polilinii şi curbe ce formează un contur închis în obiecte de tip regiune.

Putem selecta comanda din:
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Bara de instrumente Draw
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Meniul derulant Draw » Region
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Linia de comanda

Command: region
Select objects: (se selectează obiectele ce vor forma o regiune)
Select objects:<enter>

1 loop extracted. (se raportează numărul de bucle extrase şi formate din obiectele selectate)
1 Region created Command: (se raportează numărul de regiuni create)
Pentru a putea forma o regiune, succesiunea de linii ce formează conturul închis trebuie să aibă extremităţile comune.

Activităţi Obiectiv 3.

Obiectiv 3

Să afişeze desenele utilizând comenzile de vizualizare 

Fişa de documentare nr.6

Pregătirea spaţiului de lucru. Vizualizarea

Fişa de documentare conţine informaţii despre cum ne pregătim propriul mediu de lucru 3D. În acest fel veţi învăţa baza conceptelor de  VPOINT şi VIEW.

Ar fi indicat să începem prin schimbarea unghiului de vedere înainte de începerea lucrului în 3D. În acest fel, vom putea avea o vedere spaţială a modelului nostru. Iată o secvenţă de pregătire:

· Prima dată pregătim unghiul de vedere utilizând VPOINT.

Command: VPOINT 
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Current view direction:  VIEWDIR=0.0000,0.0000,1.0000

Specify a view point or [Rotate] <display compass and tripod>:
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Pe ecran vor apărea compasul şi tripodul. În colţul din dreapta sus va apărea simbolul compasului format din două cercuri concentrice cu două diametre. Simbolul este o reprezentare intuitivă a unei sfere de pe suprafaţa căreia se priveşte spre centrul acesteia, desenul. Veţi observa că, dacă mutăm mouse-ul în interiorul figurii, cursorul - o cruciulită (reprezintă poziţia observatorului), se va deplasa şi el. Odată cu acesta şi axele UCS-ului (tripod-ul) îşi vor modifica poziţia.

Un punct selectat în interiorul cercului mic creează o vedere a modelului de sus în jos (dinspre partea pozitivă a axei Z), iar un punct în exteriorul lui creează o vedere de jos în sus (dinspre partea negativă a axei Z). 

O linie orizontală împarte globul în două părţi: un punct sub linie, înseamnă vedere din faţă, un punct deasupra vedere din spate.

În tabelul de mai jos am sintetizat folosirea compasului:

	
	Interiorul cercului mic
	Exteriorul cercului mic

	Deasupra liniei orizontale
	Vedere din spate-sus
	Vedere din spate-jos

	Sub linia orizontală
	Vedere din faţă-sus
	Vedere din faţă-jos


Exemple de poziţii ale punctului de vedere pentru un corp:
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fig.1 - vedere din faţă-sus





fig.2 - vedere din spate-sus
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Se poate obţine acelaşi unghi de vedere ca cel din fig.1 prin comanda VP în linia de comandă, utilizând setările din figură.

Command: VPOINT 

Current view direction:  VIEWDIR=0.0000,0.0000,1.0000

Specify a view point or [Rotate] <display compass and tripod>:(se introduc coordonatele punctului din care se priveşte obiectul)

[image: image150.png]


Punctul de vedere este definit de un vector care porneşte din punctul a cărui coordonate sunt precizate şi origine - vârful vectorului (0,0,0).

Vectorul din figură, determinat de punctul (0,-1,0) şi (0,0,0) determină o vedere din faţă (FRONT). El este perpendicular pe planul XZ.

Bara de instrumente View
Se poate alege rapid o direcţie predefinită de vedere.
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· După obţinerea celui mai potrivit unghi de vedere a piesei putem activa introducerea GRID lines. Asiguraţi-vă că butonul GRID de sub lina de comandă este apăsat şi introduceţi setările sale prin click dreapta de mouse pe el. 
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Acum suntem gata să lucrăm în mediul 3D. Totuşi, ar fi bine să salvăm acest mediu de lucru pentru a nu pierde timpul cu refacerea setărilor de fiecare dată când începem modelarea 3D. Pentru aceasta, utilizăm comanda VIEW. În fereastra care apare selectăm butonul „New...” şi definimi o nouă vedere, pe care o denumin, de exemplu, modelare 3D.
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De acum înainte, când dorim să utilizăm această vedere, o putem selecta din:
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din meniul View» Named views....
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linia de comandă  View

Activitatea de învăţare nr.2

Obiectivul activităţii

Această activitate vă va ajuta să vă formaţi deprinderea de a vizualiza un obiect din mai multe direcţii

Tipul de activitate

Efectuare de exerciţii
Timpul alocat

20 minute
Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici, 2-3 elevi
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În tabel sunt prezentate vederi ale obiectului de mai sus. Scrieţi în dreptul fiecărei vederi direcţia  de vizualizare corespunzătoare, din comanda View
	Direcţia
	Vedere
	Direcţia
	Vedere
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Activităţi Obiectiv nr. 4

Obiectiv 4

Să realizeze desene 3D în model wireframe

Activitatea de învăţare nr. 3

Obiectivul activităţii
Această activitate vă va ajuta să învăţaţi să realizaţi un model wireframe 3D utilizând sistemul de coordonate propriu 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

50 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

Prin modelare wireframe sau modelare prin structură de sârmă se înţelege o redare sub formă de schelet a unui obiect 3D. Un astfel de model nu are suprafeţe ci doar muchii constituite din drepte şi curbe.

Pentru desenarea muchiilor se utilizează comenzile de desenare 2D şi de editare 2D.

Este foarte importantă definirea şi manevrarea corectă a sistemului de coordonate al utilizatorului (UCS).
Sarcina de lucru:

În tabel sunt prezentate etapele de realizare a modelului de mai jos. Realizaţi etapele folosind comenzile potrivite, ajutându-vă de punctele date în desenele fiecărei etape.

În coloana explicaţii/dialog scrieţi comanda utilizată
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	Nr
	Desen
	Explicaţii/dialog

	1
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	· Se întocmeşte conturul bazei



	2
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	· Se copiază conturul bazei cu 66 de unităţi pe direcţia pozitivă  axei Oz



	3
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	· Se mută segmentul S1 cu 39 de unităţi pe direcţia pozitivă a axei Ox



	4
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	· Se retează capeteleS2, S3

· Se trasează conturul P1, P2, P3, P4



	5
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	· Se completează desenul unind P3 cu P6, P2 cu P5, etc

	6
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	· Se mută UCS-ul pe faţa înclinată

· Se desenează cercul utilizând filtre ale coordonaelor:




Temă: Încercaţi să găsiţi soluţii ale exerciţiului, care să utilizeze mai puţine comenzi, folosind facilităţi de desenare 2D învăţate în clasa a XI-a.

Activităţi Obiectiv nr. 6

Obiectiv 6

Să realizeze desene 3D de corpuri solide

Fişa de documentare nr. 7

MODELAREA 3D A CORPURILOR SOLIDE. CREAREA PRIMITIVELOR

Obiectele solide sunt, ca aspect, asemănătoare cu modelele wireframe şi cu suprafeţele. diferenţa constă în uşurinţa cu care se manevrează şi editează şi în faptul că unui solid i se pot stabili proprietăţi cum ar fi masa, centrul de greutate, etc.

Una dintre cele mai uşoare metode de a construi un solid este de a crea primitivepredefinite, cum ar fi conul, paralelipipedul, sfera, etc., şi apoi utilizarea operaţiilor booleene pentru combinarea lor.

Vom învăţa în continuare modul de creare a primitivelor:

Sphere – Sferă




Cone - Con

Box – Prismă patrulateră



Wedge – Prismă triunghiulară

Cylinder - cilidru 




Torus - Tor
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Bara de instrumente
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Linia de comandă, prin comenzile:

BOX, SPHERE, CYLINDER, CONE, WEDGE, TORUS
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Meniul derulant Draw » Solids » 

Activitatea de învăţare nr. 4

Obiectivul activităţii
Această activitate vă va oferi posibilitatea exersării comenzile de creare a solidelor predefinite

Tipul de activitate

Exersare abilităţi

Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

Realizaţi solidele predefinite din tabelul de mai jos.

	Icon
	Denumire
	Dialog linie comandă
	Desen
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	BOX
	Command: BOX
Specify corner of box or [CEnter] <0,0,0>: <enter>
Specify corner or [Cube/Length]: L
Specify length: 48
Specify width: 38
Specify height: 28
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	SPHERE
	Command: SPHERE
Current wire frame density:  ISOLINES=4

Specify center of sphere <0,0,0>:<enter>
Specify radius of sphere or [Diameter]: 50
Command: ISOLINES
Enter new value for ISOLINES <4>: 16
Command: _regen Regenerating model.
	[image: image185.png]



[image: image186.png]





	[image: image187.png]



	CYLINDER
	Command: CYLINDER
Current wire frame density:  ISOLINES=20

Specify center point for base of cylinder or [Elliptical] <0,0,0>: <enter>
Specify radius for base of cylinder or [Diameter]: 50
Specify height of cylinder or [Center of other end]: 100
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	CONE


	Command: CONE
Current wire frame density:  ISOLINES=20

Specify center point for base of cone or [Elliptical] <0,0,0>: <enter>
Specify radius for base of cone or [Diameter]: 50
Specify height of cone or [Apex]: 100
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	WEDGE
	Command:

WEDGE

Specify first corner of wedge or [CEnter]  <0,0,0>: <enter>
Specify corner or [Cube/Length]: L
Specify length: 80
Specify width: 50
Specify height: 100
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	TORUS
	Command: _torus
Current wire frame density:  ISOLINES=16

Specify center of torus <0,0,0>: <enter>
Specify radius of torus or [Diameter]: 30
Specify radius of tube or [Diameter]: 5
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Variabila ISOLINES controlează modul de afişare wireframe la cilindru, sferă, tor, prin numărul de generatoare paralele de pe suprafaţa corpului.

Fişa de documentare nr. 8

CREAREA MODELELOR 3D UTILIZÂND OPERAŢIILE BOOLEENE

Puteţi crea solide complexe folosind operaţiile booleene.

Operaţiile Booleene se aplică în cazul solidelor pentru a le reuni, intersecta sa pentru a face diferenţa dintre ele.
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Reunirea dintre A şi B

A UNION B
UNION permite crearea unui obiect compus prin reunirea mai multor solide
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Diferenţa dintre A şi B

A SUBTRACT B
SUBTRACT permite crearea unui nou obiect prin eliminarea zonei comune solidelor şi a obiectelor extrase
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Intersectarea A cu B

A INTERSECT B
INTERSECT permite crearea unui nou obiect din zona comună a mai multor solide.

Efectuarea operaţiilor se poate face cu:

[image: image198.png]


Comanda: UNION sau UNI 

Comanda SUBTRACT sau SU
Comanda INTERSECT sau IN
[image: image199.png]



Bara de instrumente Solids Editing
[image: image200.png]
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Meniul derulant: Modify » Solids Editing »
[image: image202.png]



Activitatea de învăţare nr. 5

Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi efectul operaţiilor booleeene

Tipul de activitate

Efectuare de exerciţii
Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

Recunoaşteţi operaţiile booleene efectuate cu cele 2 corpuri – paralelipipedul şi cilindrul – şi scrieţi denumirea comenzii corespunzătoare în ultima coloană a tabelului.

	
	Afişare umbrită


	Afişare wireframe


	Operaţia efectuată

	Înainte
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	După efectuarea operaţiilor booleene
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Fişa de documentare nr. 9

CREAREA MODELELOR 3D UTILIZÂND COMANDA REVOLVE
Comanda REVOLVE crează corpuri solide prin rotirea unui profil plan închis, cu un unghi cuprins între 0 şi 360o, în jurul unei axe. Profilul poate fi: o polilinie închisă, un cerc, elipsă, poligoane, curbe spline închise, regiuni.
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Operaţia se poate executa din:
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Meniul derulant Draw » Solids » Revolve
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Bara de instrumente Solids
[image: image214.png]
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Linia de comandă

Command: revolve
Current wire frame density:  ISOLINES=4 (densitatea generatoarelor echidistane în modul de afişare wireframe)
Select objects: (se selectează polilinia)
Select objects: <enter>
Specify start point for axis of revolution or

define axis by [Object/X (axis)/Y (axis)]: (se selectează un punct de pe axa de rotaţie P1)
Specify endpoint of axis: (se selectează al doilea punct de pe axa de rotaţie P2)
Specify angle of revolution <360>: (se introduce valoarea unghiului de rotaţie, 180o în primul caz şi 360o în al doilea)
Axa de rotaţie mai poate fi un obiect şi atunci selectăm O (Object) din opţiunile comenzii sau poate fi axa X sau axa Y, caz în care alegem opţiunea X respectiv Y.
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Activitatea de învăţare nr. 6

Obiectivul activităţii
Cu ajutorul acestei activităţi veţi exersa comanda REVOLVE pentru crearea unui corp solid

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

1. Foloseşte comanda 2Dpolyline pentru a crea conturul închis din desenul de mai jos (cu dimensiuni alese de tine). 

2. Crează apoi solidul prin utilizarea comenzii REVOLVE, precizând punctele axei de rotaţie cu ajutorul modului OSNAP
[image: image217.png]



[image: image218.png]



Fişa de documentare nr. 10

CREAREA MODELELOR 3D UTILIZÂND COMANDA EXTRUDE
Comanda EXTRUDE are ca efect crearea de corpuri solide prin extrudarea poliliniilor închise, a cercurilor, elipselor, curbelor spline închise sau regiunilor.
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Meniul derulant Draw » Solids » Extrude
[image: image221.png]



Linia de comandă

Command: _extrude

Current wire frame density: ISOLINES=4

Select objects: (se selectează curba închisă)
Specify height of extrusion or [Path]: (se specifică înălţimea dorită sau calea de-a lungul căreia se face extrudarea)
Specify angle of taper for extrusion [Path]<0>: (se indică unghiul de înclinare dorit sau calea de-a lungul căreia se face extrudarea)
[image: image222.png]



Bara de instrumente
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Activitatea de învăţare nr. 7

Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi efectul comenzii EXTRUDE în creerea modelelor 3D solide 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

[image: image224.png]


Desenul alăturat constă dintr-o regiune [1], o polilinie în formă de U [2] şi un dreptunghi [3].

Pentru obiectele din desen se aplică comanda EXTRUDE de mai multe ori.  Efectul comenzii este reprezentat în ultima coloană.

Scrieţi corespondenţa corectă dintre litera corespunzătoare comenzii şi cifra corespunzătoare desenului final (efectul comenzii respective)

	
	Dialog/Linia de comandă
	
	Efectul comenzii

	A
	Command: _extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 3)

Select objects: <enter>
Specify height of extrusion or [Path]: 3
Specify angle of taper for extrusion <0>: 10

	1
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	B
	Command: _extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 1)

Select objects: <enter>
Specify height of extrusion or [Path]: p
Select extrusion path or [Taper angle]: (se selectează 2)


	2
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	C
	Command: extrude

Current wire frame density:  ISOLINES=4

Select objects: (se selectează 3)

Select objects: <enter>
Specify height of extrusion or [Path]: 3
Specify angle of taper for extrusion <0>: <enter>

	3
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	D
	Command: extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 1)

Select objects: <enter>
Specify height of extrusion or [Path]: 5
Specify angle of taper for extrusion <0>: 10

	4
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A

____

B

____

C

____

D

____

Activitatea de învăţare nr. 8

Obiectivul activităţii
Această activitate vă va ajuta să exersaţi abilitatea de a utiliza comanda EXTRUDE pentru crearea modelelor 3D solide 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

40 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

1. Realizaţi modelul 2D din desenul de mai jos, respectând cotele, cu ajutorul unei singure comenzi.

2. Realizaţi corpul solid din figura 2 cu comanda EXTRUDE. Extrudarea se va face pe o înălţime de 30 şi cu un unghi de 8o.
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Activităţi Obiectiv nr. 7
Obiectiv 7 Să realizeze secţiuni în modele 3D

Fişa de documentare nr. 11

Realizarea secţiunilor

Reprezentarea în secţiune a unui corp se face cu scopul înţelegerii formei interiorului acestuia.

Una dintre comenzile de secţionare este SLICE.

[image: image231.png]


Efectul comenzii este „tăierea” unui corp în două părţi cu un plan.

Pentru efectuarea comenzii trebuie selectat obiectul ce va fi taiat apoi se stabileşte planul de secţionare

Operaţia se poate efectua astfel:
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Linia de comandă

Command: SLICE

Select objects to slice: (se selectează obiectul sau obiectele de secţionat)
Select objects to slice: <enter> (se încheie selectarea)
Specify start point of slicing plane by [Object/Zaxis/View/XY/YZ/ZX/3points] <3points>: (se introduce una dintre opţiuni)
Specify a point on desired side or [keep Both sides] <Both>:

Opţiunile de determinare a planului de secţionare sunt:

O (Object)
alinierea planului de secţionare la un obiect din desen

Z (Z Axis)
specificarea unui punct din planul de secţionare şi un punct de pe axa Z perpendiculară pe plan

V (View)

aliniază planul de secţionare cu planul de vizualizare

XY 


aliniază planul de secţionare cu planul determinat de axele X şi Y ale UCS curent

YZ


aliniază planul de secţionare cu planul determinat de axele Y şi Z ale UCS curent

XZ


aliniază planul de secţionare cu planul determinat de axele X şi Z ale UCS curent

3 (3 points)
determină planul de secţionare prin trei puncte
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În figura de mai jos sunt exemplificate planele XY, YZ, XZ
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Bara de instrumente
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Meniul derulant Draw » Solids » Slice
Activitate de învăţare nr. 9

Obiectivul activităţii
Prin efectuarea acestei activităţi veţi exersa opţiunile comenzii SLICE pentru realizarea unei secţiuni 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

40 minute

Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici, 2-3 elevi

Numele elevului __________________

Data ___________

Deschideţi fişierul ce conţine desenul 3D afişat în modul Gouraud Shaded
Efectuaţi comanda SLICE pentru obiectul din desen, alegând, pe rând, fiecare opţiune pentru alegerea planului de secţionare.

	Opţiune
	Obiect de secţionat
	Efect comandă SLICE

	O

Object
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	P2 punctul de selecţie al corpului păstrat

	Z

Z axis
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	P1 punctul din plan (centrul găurii orizontale)

P2 punctul de pe axa Z (mijlocul muchiei)

P3 punctul de selecţie al corpului păstrat

	V

View
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	P1 punctul prin care trece planul vederii

P2 punctul de selecţie al corpului păstrat

	XY
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	P1 punctul prin care trece planul XY

	YZ
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	P1 punctul prin care trece planul YZ

	XZ
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	P1 punctul prin care trece planul ZX

P2 punctul de selecţie al corpului păstrat

	3

3points
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	P1, P2, P3 punctele planului de secţionare


Activităţi Obiectiv nr. 8

Obiectiv 8

Să creeze suprafeţe 3D simple şi compexe

Fişa de documentare nr. 12

Modelarea suprafeţelor 3D simple

Pentru modelarea suprafeţelor în AutoCAD se utilizează reţele poligonale (mesh) formate din faţete care aproximează suprafeţele curbe. 

Modelele solide pot fi transformate în suprafeţe utilizând comanda EXPLODE. De asemenea, suprafeţele pot fi convertite în modele wireframe. Totuşi, deoarece ele nu conţin aceleaşi informaţii, nu se poate face trecerea de la modelele wireframe la suprafeţe şi nici de la suprafeţe la modele 3D.

În general nu trebuie amestecate cele trei tipuri de modelare 3D deoarece nu pot fi editate în acelaşi mod, pentru a obţine o structură unitară.

Pentru modelarea unei suprafeţe, putem utiliza:
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Bara de instrumente 
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Linia de comandă

Meniul derulant Draw » Surfaces »
[image: image92.png]9 <



2D Solid; 3D Face
Comanda 3D Face permite desenarea unor suprafeţe plane în spaţiul tridimensional, prin indicarea a trei sau mai multe puncte care definesc conturul acestora. Se poate utiliza comanda Edge pentru a schimba vizibilitatea feţelor 3D

Command: 3D FACE
Specify first point or [Invisible]: (se indică primul punct);

Specify second point or [Invisible]: (se indică al doilea punct);

Specify third point or [Invisible] <exit>: (se indică al treilea punct);

Specify fourth point or [Invisible] <create three-sided face>: (se indică al patrulea punct);

Specify third point or [Invisible] <exit>: (se indică al cincilea punct);

Specify fourth point or [Invisible] <create three-sided face>: (se indică al şaselea punct);

Specify third point or [Invisible] <exit>: (se indică al şaptelea punct etc., sau se incheie dialogul cu enter)

Opţiunea I [Invisible] permite ca următoarea muchie desenată să fie invizibilă.
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Box; Wedge; Pyramid; Cone; Sphere; Dome; Dish; Torus. Se realizează suprafeţe predefinite, similare solidelor, cu diferenţa că obiectele create au numai înveliş (coajă) şi nu conţin informaţii referitoare la volum şi proprietăţi de masă.
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Meniul derulant Draw » Surfaces » 3D Surfaces...
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Din fereastra de dialog se alege, prin dublu click pe icon-ul suprafeţei predefinite sau pe denumirea ei din partea stângă, opţiunea dorită.
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Edge; 3D Mesh
Comanda 3D Mesh permite realizarea unei reţele poligonale rectangualre prin specificarea coordonatelor X, Y, Z ale punctelor reţelei (noduri).

Pentru început trebuie definite M=numărul de coloane şi N=numărul de linii ale reţelei. M şi N pot lua valori între 2 şi 256.

Fiecare patrulater al suprafeţei este determinat prin 4 noduri (vertex-uri) sau 4 muchii.

Command: 3D MESH
Enter size of mesh in M direction: (se precizează numărul de noduri pe direcţia M);

Enter size of mesh in N direction: (se precizează numărul de noduri pe direcţia N);

Specify the location for vertex (0,0): (se precizează coordonatele primului nod);

Specify the location for vertex (0,1): (se precizează coordonatele celui de-al doilea nod);

Se continuă dialogul până când se introduc toate nodurile matricii M*N

Exemplu:

Command: _3dmesh
Enter size of mesh in M direction: 3

Enter size of mesh in N direction: 3

Specify location for vertex (0, 0): 0,0,0

Specify location for vertex (0, 1): 15,0,1

Specify location for vertex (0, 2): 30,5,2

Specify location for vertex (1, 0): 0,15,0

Specify location for vertex (1, 1): 18,18,3

Specify location for vertex (1, 2): 30,15,0

Specify location for vertex (2, 0): 0,30,2

Specify location for vertex (2, 1): 15,30,0

Specify location for vertex (2, 2): 30,34,3

[image: image259.png]



Activitatea de învăţare nr. 10

Obiectivul activităţii
Această activitate vă va ajuta să învăţaţi să creaţi suprafeţe tridimensionale predefinite

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

40 minute

Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici 2-3 elevi

Numele elevului __________________

Data ___________

Veţi realiza în acelaşi spaţiu de lucru suprafeţele predefinite din desenul de mai jos, utilizând bara de instrumente sau meniul derulant şi respectând caracteristicile indicate mai jos.

1. sfera (sphere)


Centrul:
-2,0,0


Raza:

3


Numărul liniilor de reţea longitudinale
36


Numărul liniilor de reţea transversale
36
2. paralelipipedul (box)

Colţul

4,4,-2


Lungimea
8


Înălţimea
4


Unghiul de rotaţie faţă de axa Z
-10
3. conul (cone)



Centrul bazei


5,-3,-1


Raza bazei mari

4.5


Raza bazei mici

1.5


Înalţimea conului

5


Numărul liniilor de reţea de pe suprafaţă
36
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Cei care vor termina mai repede, vor realiza un torus, dish şi dome având caracteristici şi poziţii aleatoare.

Activitatea de învăţare nr. 11

Competenţa

Creează suprafeţe 3D 

Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi efectul comenzii 3DFACE la realizarea suprafeţelor 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

40 minute

Sugestii de realizare
Activitatea se poate desfăşura individual 

Numele elevului __________________

Data ___________

Am prezentat mai jos, dialogul comenzii 3DFACE prin care s-a realizat desenul alăturat.

[image: image261.png]


Realizaţi comanda şi precizaţi:

a) Câte faţete s-au creat

________________________

b) Care sunt muchiile invizibile

__________________________

c)Aplicaţi apoi comana EDGE pentru a modifica vizibilitatea muchiilor invizibile

Command: _3dface Specify first point or [Invisible]: 200,100

Specify second point or [Invisible]: @60,0,80

[image: image262.png]


Specify third point or [Invisible] <exit>: @-60,0,0

Specify fourth point or [Invisible] <create three-sided face>:

Specify third point or [Invisible] <exit>: @0,50,0

Specify fourth point or [Invisible] <create three-sided face>: i

Specify fourth point or [Invisible] <create three-sided face>: @0,0,-80

Specify third point or [Invisible] <exit>: i

[image: image263.png]


Specify third point or [Invisible] <exit>: 200,100
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Specify fourth point or [Invisible] <create three-sided face>:

Specify third point or [Invisible] <exit>:

Activitatea de învăţare nr. 12

Competenţa

Creează suprafeţe 3D
Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi efectul comenzii 3DMESH la realizarea suprafeţelor 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat


40 minute

Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici, 2-3 elevi

Numele elevului __________________

Data ___________

Să se realizeze suprafaţa din desen prin introducerea coordonatelor absolute ale fiecărui nod al reţelei.

Să se găsească modul cel ma potrivit de vizualizare
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	X
	Y
	Z

	0
	0
	170
	90
	-80

	0
	1
	200
	30
	-50

	0
	2
	240
	20
	10

	1
	0
	200
	80
	-100

	1
	1
	240
	60
	-80

	1
	2
	280
	30
	-20


Fişa de documentare nr. 13

Modelarea suprafeţelor 3D complexe

Vom continua Fişa de documentare referitoare la suprafeţele simple.

[image: image95.png]BB P



Revolved Surface; Tabulated Surface; Ruled Surface; Edge Surface
Comanda REVSURF (Revoled Surfaces) crează o reţea poligonală care aproximează o suprafaţă de revoluţie generată prin rotirea unei curbe directoare în jurul unei axe. Directoarea poate fi: linie, polilinie, arc, cerc, elipsă, curbă spline.

Densitatea reţelei poligonale este controlată de variabilele SURFTAB1 (pe direcţia M) şi SURFTAB2 (pe direcţia N-direcţia axei).

Iată un exemplu:

· stabilirea curbei directoare şi a axei de rotaţie
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· Schimbarea punctului de vedere pentru o vizualizare 3D.

[image: image270.png]



· Efectul comenzii REVSURF cu valori diferite ale variabilelor SURFTAB (mai mari în figura 2.)

Comenzile TABSURF (Tabulated Surface) şi RULESURF (Ruled Surface)
sunt două comenzi utilizate pentru crearea reţelelor 3D complexe.

Ambele comenzi utilizează variabila sistem SURFTAB1 pentru a stabili densitatea reţelei.

Comanda TABSURF crează o suprafaţă utilizând o curbă şi un vector.

O dreaptă se deplasează de-a lungul curbei rămânând paralelă cu direcţia indicată de vector.

[image: image271.png]



Desenul constă dintr-o curbă spline, o linie şi două elipse.

Command: tabsurf

Current wire frame density:  SURFTAB1=6

Select object for path curve: (se selectează curba directoare- punctul P1)

Select object for direction vector: (se selectează linia directoare- punctul P2).
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Se poate alege modul de umbrire GouraudShaded, Edges On.  

[image: image273.png]



Deoarece curba nu este bine aproximată, se va creşte valoarea variabilei SURFTAB1 la 36, şi se regenerează suprafaţa.

[image: image274.png]



Comanda RULESURF conectează două curbe prin intermediul unei reţele poligonale.

Cele două curbe pot fi închise sau deschise: puncte, linii arce, poligoane, cercuri, curbe spline

[image: image275.png]



Command: rulesurf
Current wire frame density:  SURFTAB1=36

Select first defining curve: (se selectează prima curbă- punctulP3)
Select second defining curve: (se selectează a doua curbă- punctul P4).
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Aspectul final al suprafeţei depinde şi de punctul de selectare a curbelor.

Iată un exemplu în care două curbe au fost selectate în locuri diferite.

	Dialogul din lina de comandă
	Înainte de realizarea comenzii
	După realizarea comenzii

	Command: rulesurf
Current wire frame density:  SURFTAB1=25

Select first defining curve: (se selectează P1)
Select second defining curve: (se selectează P2)
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	Command: rulesurf
Current wire frame density:  SURFTAB1=25

Select first defining curve: (se selectează P1)
Select second defining curve: (se selectează P3)
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Activitatea de învăţare nr. 13

Obiectivul activităţii
Prin efectuarea acestei activităţi veţi exersa comanda RULSURF pentru realizarea unei suprafeţe 3D complexe 

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

40 minute

Sugestii de realizare
Activitatea se poate desfăşura individual sau pe grupe mici, 2-3 elevi

Numele elevului __________________

Data ___________

[image: image281.png]@%@veéa
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Să se realizeze un hiperboloid de rotatie, respectând etapele din tabelul de mai jos.

Să se completeze în tabel celulele goale cu denumirea comenzii utilizate. (Eventual puteţi copia dialogul din linia de comanda  AutoCAD).

Cei care terminaţi mai repede, încercaţi să găsitţi o altă cale de rezolvare a etapelor 1-4 utilizînd mai puţine comenzi.

	Nr.

operaţie
	Descrierea operaţiei
	Comanda
	Desen

	0
	Se alege un punctul de vedere folosind tripodul şi compasul
	
	

	1
	Se construieşte un cerc
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	2
	Se rupe cercul
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	3
	Se copiază cercul pe direcţia axei Z la o anumită distanţă
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	4
	Se roteşte noul cerc în jurul axei Z
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	5
	Se stabileşte numărul de generatoare al suprafeţei (reţelei).


	
	[image: image286.png]





	6
	Se realizează suprafaţa rulată
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Activităţi Obiectiv nr. 9

Obiectiv 9

Să folosească facilităţile aplicaţiei AutoCAD de umbrire a suprafeţelor

Fişa de documentare nr. 14

ASCUNDEREA MUCHIILOR ACOPERITE ŞI UMBRIREA SUPRAFEŢELOR

Obiectele 3D pot fi afişate pe ecran sub mai multe forme:

· Wireframe

în care sunt reprezentate toate liinile ”cadrului de sârmă”

· HIDE


în care sunt reprezentate numei muchiile vizibile

· SHADE şi RENDER
în care se umbresc suprafeţele vizibile

Pentru afişarea umbrită a obiectelor 3D se utilizează:

[image: image288.png]



Meniul derulant: View » Shade »
[image: image289.png]
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Comanda: SHADEMODE 

Command: shademode
Current mode: 2D wireframe

Enter option [2D wireframe/3D wireframe/Hidden/Flat/Gouraud/fLat+edges/gOuraud+edges] <2D wireframe>: (se alege una dintre opţiunile 2D, 3D, H, F, G, L, O)
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Bara de instrumente

[image: image292.png]



Afişează obiectele utilizând linii şi curbe pentru reprezentarea muchiilor

[image: image293.png]



Afişează obiectele utilizând linii şi curbe pentru reprezentarea muchiilor. Afişează iconul UCS în 3D
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Afişează obiectele în modul 2D wireframe şi ascunde liniile corespunzătoare muchiile acoperite
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Umbreşte feţele poligonale ale obiectului. Obiectele apar cu faţete între care nu exită continuitate ca la modul Gouraud.
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Afişează obiectele umbrite cu muchiile dintre faţete netezite oferind obiectului un aspect realist.
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Este o combinaţie a modului de umbrire Flat şi Wireframe. Obiectul este umbrit Flat şi sunt vizibile şi liniile cadrului de sârmă
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Este o combinaţie a modului de umbrire Gouraud şi Wireframe. Obiectul este umbrit Gouraud şi sunt vizibile şi liniile cadrului de sârmă

Activitatea de învăţare nr. 14

Obiectivul activităţii
Această activitate vă va ajuta să folosiţi comanda SHADEMODE pentru afişarea suprafeţelor 3D 
Tipul de activitate

Efectuare de exerciţii

Timpul alocat

15 minute

Sugestii de realizare
Activitatea se desfăşoară individual

Numele elevului __________________

Data ___________

Este afişată o suprafaţă tridimensională dish în mai multe moduri. Recunoaşteţi cele 7 moduri de umbrire ale comenzii 

SHADEMODE: 

[2D wireframe/3D wireframe/Hidden/Flat/Gouraud/fLat+edges/gOuraud+edges]
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Activităţi Obiectiv nr. 10

Obiectiv 10

Să afişeze un desen în modul „multiview”

Fişa de documentare nr. 15
OBŢINEREA VEDERILOR MULTIPLE - „MULTI VIEW”

Viewporturile ne permit vizualizarea desenului din mai multe puncte de vedere în acelaşi timp. Numeroase opţiuni de afişare, cum ar fi: factorul de zoom sau modul de umbrire (shademode) pot fi aplicate în fiecare viewport.

Există două tipuri de viewporturi disponibile în AutoCAD: TILED (alăturate) şi FLOATING (mobile).

TILED VIEWPORTS pot fi folosite numai în spaţiul model (MODEL SPACE)

FLOATING VIEWPORTS pot fi folosite doar în PAPER SPACE
MODEL SPACE este un mediu tridimensional în care are loc activitatea de desenare 2D sau 3D şi reprezintă ecranul implicit afişat la inceperea unui desen nou.

Pentru tipărirea în condiţii bune a unui desen a fost creat spaţiul de hârtie  („foaia de hârtie”) PAPER SPACE. Acesta este un spaţiu bidimensional în care se pot plasa mai multe vederi ale aceluiaşi obiect, în care poate fi inserat chenarul şi indicatorul, elemente ce nu au de a face cu modelul ci care trebuie sa apară numai la tipărire.

Variabila TILEMODE este o variabilă sistem care controlează tipul viewport-urilor şi poate ave 2 valori:

1
ecranul este în MODEL SPACE şi poate fi împărţit în viewportu-ri alăturate  cu ajutorul comenzii VPORTS
[image: image306.png]


0
ecranul este în PAPER SPACE şi poate fi împărţit în viewportu-ri mobile cu ajutorul comenzii MVIEW
În continuare vom introduce comanda VPORTS din

[image: image307.png]


Meniul derulant View » Viewports » New Viewports
Bara de instrumente


Linia de comandă

Command: vports
Activitatea de învăţare nr. 15

Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi modul de reprezentare multiview

Tipul de activitate

Efectuare de exerciţii

Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura pe grupe de 2-3 elevi

Numele elevului __________________

Data ___________

Vom crea mai multe VIEWPORT-uri pentru desenul alăturat 

Accesând opţiunea VPORTS prin oricare din cele trei metode apare fereastra de dialog din fig.1

În care alegem 

Din lista Standard Viewport
opţiunea Three: Left
Din lista derulantă Setup

opţiunea 3D

Pe ecran vor apărea 3 vederi diferite ale aceleaşi piese adică 3 viewport-uri ca în desenul de mai jos. Selectând, pe rând, cu mouse-ul viewport-urile se pot stabili diferite moduri de vizualizare ale obiectului.


Selectăm viewport-ul din dreapta sus şi din nou apelăm comanda VPORTS. În caseta de dialog vom alege:

Din lista Standard Viewport

opţiunea Two: Vertical
Din lista derulantă Change view to:
opţiunea Right pentru fereastra din dreapta






opţiunea Right pentru fereastra din dreapta

Din lista derulantă Apply to:

opţiunea Current Viewport
în caseta New name


numele exerciţiu


Ecranul se va schimba ca în desenul de mai jos


Pentru vederea 3D am ales modul de umbrire Gouraud Shaded Edges On
Daca dorim sa apelăm unul dintre viewporturile create cu diverse nume, în fereastra Viewports alegem Named Views.


Activitatea de învăţare nr. 16

Obiectivul activităţii
Această activitate vă va ajuta să exersaţi realizarea modului de reprezentare multiview
Tipul de activitate

Efectuare de exerciţii

Timpul alocat

20 minute

Sugestii de realizare
Activitatea se poate desfăşura individual

Numele elevului __________________

Data ___________

· Încearcă singur, să obţii ecranul de mai jos cu comanda VPORTS. 

· Salvează acest viewport cu un nume ales de tine.


· Scrie mai jos, ce opţiuni ai ales în fereastra de dialog pentru 

Lista Standard Viewport


_________________________________________

Lista derulantă Change view to:

_________________________________________







_________________________________________
Din lista derulantă Apply to:

_________________________________________

Caseta New name



_________________________________________

Lista derulantă Setup


_________________________________________

Activităţi Obiectiv nr. 11

Obiectiv 11

Să realizeze trecerea de la reprezentarea în proiecţie paralelă la reprezentarea în perspectivă 

Fişa de documentare nr. 16
Afişarea pe ecran a obiectelor 3D în proiecţie paralelă, se realizează cu ajutorul comenzii VPOINT şi variantelor acesteia.

Modul de reprezentare a unui corp în perspective corespunde vederii umane. Afişarea în perspectivă oferă o viziune realistă obiectelor.

Comanda DVIEW (Dynamic View) permite afişarea în proiecţie paralelă sau în proiecţie conică (perspectivă).

Termenii utilizaţi în acest mod de reprezentare sunt

Target - punctul ţintă - punctul spre care se priveşte

Camera - aparat fotografic - locul în care se găseşte observatorul.

Direcţia de vizualizare este dinstpre Camera spre Target. 

Opţiunile comenzii DVIEW cu ajutorul cărora se obţin diferite efecte, sunt:

Distance
D
deplasarea camerei de-a lungul direcţiei de vizualizare.

Numai după validarea opţiunii Distance  se va face trecerea de la proiecţia paralelă la proiecţia conică

Zoom

Z
ajustarea distanţei focale a camerei

Twist
TW
rotirea vederii de-a lungul liniei de vizalizare

off 

O
din vederea în perspectivă la vederea în proiecţie paralelă

Hide 
H
eliminarea liniilor ascunse

Clip


obscurizarea porţiunilor aflate în spatele unor plane de tăiere

Pan 

P
Deplasarea ecranului 

Undo 
U
anularea unor operaţii

Exemplu de utilizare a comenzii: 

Pentru cele şase primitive din desenul de mai jos, reprezentat în proiecţie paralelă se realizează trecerea la proiecţia paralelă cu ajutorul comenzii DVIEW


Iată dialogul din linia de comandă:

Command: dview
Select objects or <use DVIEWBLOCK>: all (se selectează automat toate obiectele din desn)
30 found

Select objects or <use DVIEWBLOCK>: <enter>
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: po
Specify target point <121.9049, 55.6429, 80.3843>: 100,200
Specify camera point <-441.5975, -251.4629, 368.2631>: 300,-100,150
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: d
Specify new camera-target distance <390.5125>: <enter> (se acceptă valoarea implicită)
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: pa
Specify displacement base point: (se indică un punct)
Specify second point: (se deplasează punctul cu mouse-ul pe ecran)
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: z
Specify lens length <50.000mm>: 35 (distanţa focală obişnuită la aparatele foto)
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: h
Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: <enter>

Este exemplificat mai jos rezultatul comenzii.

Activitatea de învăţare nr. 17

Obiectivul activităţii
Această activitate vă va ajuta să înţelegeţi modul de de acţiune al comenzii DVIEW
Tipul de activitate

Efectuare de exerciţii

Timpul alocat

30 minute

Sugestii de realizare
Activitatea se poate desfăşura individual

Numele elevului __________________

Data ___________

În desenul alăturat s-au reprezentat două corpuri în proiecţie paralelă. Reprezentaţi corpurile în perspectivă.

· Se construiesc cele două corpuri astfel:

Cilindrul
centrul bazei (0,0,0)



Înălţimea h = 90

Prisma (box)
corner QUA OF baza cilindrului



L =3 0



W = 20



H = 100

· Se aplică comanda DWIEW cu rmătoarele opţiuni:

POints

target point
– 0,0,0



Camera point
- 180,-100,200

D

Se acceptă distanţa implicită

Pa



Z

35

H



9. Soluţii de activitate

EVALUARE INIŢIALĂ

1. ora 3

2. World Coordinate System

3. Z

4. da

5. Apăsarea tastelor Alt+P

6. Linia de comandă

7. arce

8. control+Z

9. muchii tăietoare

10. depinde de obiect

11. două

12. unul

13. jos

14. 3 mm

15. 4 mm

16. utilizând comanda RECTANGLE

17. ambele variante

18. colţuri rotunjite

19. dispuse în formă circulară

20. întotdeauna

21. câte sunt necesare pentru afişarea clară a obiectului

22. când începem desenul

Activitatea de învăţare nr.3
	Nr
	Desen
	Explicaţii/dialog

	1
	

	· Se întocmeşte conturul bazei

Command: LINE
Specify first point: (se indică P1 oarecare)

Specify next point or [undo]: @70,0
Specify next point or [undo]: @0,100
Specify next point or [close/undo]: @-70,0
Specify next point or [close/undo]: c


	2
	

	· Se copiază conturul bazei cu 66 de unităţi pe direcţia pozitivă  axei Oz

Command: COPY
Select objects: Specify opposite coner: 4 found

Select objects: 
Specify base place of displacent, or [Multiple]: (se specifică un punct oarecare)
Specify second point of displacement or <use first point as dispacement>: @0,0,66


	3
	

	· Se mută segmentul S1 cu 39 de unităţi pe direcţia pozitivă a axei Ox

Comanda: MOVE
Select objects: (selectare în S1) 1 found

Select objects: 
Specify base place of displacent: (se indică un punct oarecare)
Specify second point of displacement or <use first point as dispacement>: @39,0,0


	4
	

	· Se retează capeteleS2, S3

Command: TRIM
Select cutting edges ...

Select objects: (selectare în S1) 1 found
Select objects: 

Select objects to trim or shift-select to extend or [Project/Edge/Undo]: (select S2)
Select objects to trim or shift-select t extend or [Project/Edge/Undo]: (select S3)
· Se trasează conturul P1, P2, P3, P4

Command: LINE
Specify first point: _endp of (P1)
Specify next point or [Undo]: @0,0,23

Specify next point or [Undo]: @0,100,0

Specify next point or [Close/Undo]: end of (P4)



	5
	

	· Se completează desenul unind P3 cu P6, P2 cu P5, etc.

Această etapă o veţi realiza  folosind modul OSNAP



	6
	
	· Se mută UCS-ul pe faţa înclinată

Command: UCS
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?World] <World>: N
Specify origyn of new UCS or [Zaxis/3point/Object/Face/View/X/Y/Z] <0,0,0>:3
Specify new origin point <0,0,0>: _endp of
Specify point on positive portion of X axis <322.7911,10.5901,23.0000>: _endp of
Specify point on positive-Y portion of the UCS XY plane <322.7911,10.5901,23.0000>: endp of (la cele trei cereri s-au indicat punctele P3, P2, P6, capetele segmentelor respective)

· Se desenează cercul utilizând filtre ale coordonaelor:

Command: CIRCLE

Specify centre point for circle or [3P/2P/Ttr (tan tan radius)]: .x
of mid (se selectează în S1)

of (need YZ): mid
of (se selectează S2)

Specify radius of circle or [Diamete <0.0000>: 20


Activitatea de învăţare nr.2

	Direcţia
	Vedere
	Direcţia
	Vedere

	SW
	

	FRONT
	


	SE
	
	BOTTOM
	


	NV
	

	RIGHT
	


	BACK
	
	NE
	


	LEFT
	

	TOP
	


Activitatea de învăţare nr.5
	
	Afişare umbrită


	Afişare wireframe


	Operaţia efectuată

	Înainte
	

	

	

	După efectuarea operaţiilor booleene
	

	

	INTERSECT

	
	

	
	UNION

	
	
	

	SUBTRACT


Activitatea de învăţare nr.7

	A
	Command: _extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 3)

Select objects: <enter>
Specify height of extrusion or [Path]: 3
Specify angle of taper for extrusion <0>: 10

	3
	


	B
	Command: _extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 1)

Select objects: <enter>
Specify height of extrusion or [Path]: p
Select extrusion path or [Taper angle]: (se selectează 2)


	1
	


	C
	Command: extrude

Current wire frame density:  ISOLINES=4

Select objects: (se selectează 3)

Select objects: <enter>
Specify height of extrusion or [Path]: 3
Specify angle of taper for extrusion <0>: <enter>

	4
	


	D
	Command: extrude
Current wire frame density:  ISOLINES=4

Select objects: (se selectează 1)

Select objects: <enter>
Specify height of extrusion or [Path]: 5
Specify angle of taper for extrusion <0>: 10

	2
	



Activitatea de învăţare nr.13

	Nr.

operaţie
	Descrierea operaţiei
	Comanda
	Desen

	0
	Se alege un punctul de vedere folosind tripodul şi compasul
	VPOINT
	

	1
	Se construieşte un cerc
	CIRCLE
	


	2
	Se rupe cercul


	BREAK
	


	3
	Se copiază cercul pe direcţia axei Z la o anumită distanţă


	COPY
	


	4
	Se roteşte noul cerc în jurul axei Z


	ROTATE
	


	5
	Se stabileşte numărul de generatoare al suprafeţei (reţelei).


	SURFTAB1
	


	6
	Se realizează suprafaţa rulată


	RULESURF
	



Activitatea de învăţare nr.11

S-au realizat 2 faţete 3D

Muchiile invizibile sunt P1-P4 şi P2-P5

Efectul comenzii EDGE de schimbare a vizibilităţii muchiilor.


Activitatea de învăţare nr. 14

	

	


	3D WIREFRAME


	FLAT SHADED

	

	

	GOURAUD SHADED


	FLAT SHADED, EDGES ON

	

	

	GOURAUD SHADED, EDGES ON


	2D WIREFRAME

	

	

	HIDDEN


	


Activitatea de învăţare nr. 17


Command: dview

Select objects or <use DVIEWBLOCK>: all

2 found

Select objects or <use DVIEWBLOCK>:

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: po

Specify target point <34.2099, 29.6346, 28.6891>: 0,0

Specify camera point <291.6233, -385.1868, 164.3332>: 180,-100,200

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: d

 pecify new camera-target distance <287.0540>:

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: pa

Specify displacement base point:

Specify second point:

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: z

Specify lens length <50.000mm>: 35

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]: h

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]:

Regenerating model.
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Prezentul Auxiliar didactic nu acoperă toate cerinţele cuprinse în Standardul de Pregătire Profesională al calificării pentru care a fost realizat. Prin urmare, el poate fi folosit în procesul instructiv şi pentru evaluarea continuă a elevilor, însă, pentru obţinerea Certificatului de calificare, este necesară validarea integrală a competenţelor din S.P.P., prin probe de evaluare conforme celor prevăzute în standardul respectiv.
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Profilul: TEHNIC
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